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The most successful traders and investors think like analysts: they study patterns, 
measure behavior over time, and make decisions based on evidence rather than 

emotion. The real edge comes from turning raw market information into actionable 
signals. Insider filings don’t predict the market, but when analyzed properly, they can 
reveal valuable signs about conviction, incentives, and timing that price action alone 

often hides. Insider transactions alone don’t make trades. Insight does. 

We at InsiderIQ Pro can only provide the raw material. Your analysis, judgment, and risk 
management turn it into an opportunity. 
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GATHER & CLEAN UP YOUR DATA 
 
 

 
 
 
Open up a Google Sheet Workbook, you should be presented with a blank sheet. This 
is your new Insider Trades database. As you receive more insider data keep them within 
this database to stay organized. 
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On a blank sheet, Import the sec_filing.csv file via the “Upload” tab. 
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To remain on the same sheet you are already on, when you see the drop down menu 
that says “Create New Spreadsheet”, click on it and select “Replace current 
spreadsheet”. Then continue. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Visit: www.insideriqpro.com 
 

http://www.insideriqpro.com


 
 
 

 
 
 
 
After import, highlight all rows by clicking the white square at the very top right corner of 
your spreadsheet. 
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Under the Data tab, hover your mouse over “Data cleanup”, and you should get the 
option to “Remove duplicates”. 
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Check the box that says “Data has header row” then click “Remove duplicates”. Once 
that is done, your data is now clean and ready to give you quality information to 
trade/invest on. 
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UNDERSTANDING YOUR DATA 

 

 
 
 
 
If done correctly, you should now see all the transactions filed for that particular trading 
day present in your google sheet. I advise that you name your sheet by the filing date to 
keep yourself organized. Being organized is very important as a data analyst. You can 
do that by right-clicking on the “Sheet1” tab at the very bottom on the left side of your 
sheet and selecting “Rename”. 
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Next, familiarize yourself with all the columns and the information they contain: 
 
Form Type: This show if the transaction is a Form 4 (Filed when an insider executes a 
transaction ) or a Form 3 transaction (Filed when a person firsts becomes an insider (for 
example, when they are hired as an officer or director), to initially disclose his or her 
ownership of the company’s securities.). 
 
URL: This is the link to the actual SEC filing. There is both an XML version and a HTML 
version, which is more human-readable on the SEC website. The URLs on the 
spreadsheet lead you to the XML version. In order to see the HTML version which is 
more human-readable, add “/xslF345X05” right before the last tab on the URL. 
 

Ex:   
 

XML Version URL: 
https://www.sec.gov/Archives/edgar/data/1045810/000119765025000009/wk-form4_17

66008616.xml 
 

HTML Version URL: 
https://www.sec.gov/Archives/edgar/data/1045810/000119765025000009/xslF345X05/w

k-form4_1766008616.xml 
 
 

Filing Date:  This shows the date the transaction was filed with the SEC. 
 
Company Name:  This is the name of the company whose shares are involved in the 
transaction..Ex, Alphabet Inc. 
 
Ticker Symbol:  This is the ticker symbol of the company whose shares are involved in 
the transaction. Ex..GOOGL (Company Name: Alphabet Inc.) 
 
Insider Name: This is the name of the company’s insider carrying out the stock trade. 
 
Insider Position (Is Director, Is Officer, Is Ten Percent Owner): This is the position 
the particular insider holds within the company. There are 3 main categories. Directors,  
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which are any members on the company’s board of directors, Officers such as the CEO 
or CFO and Ten percent owner, which is any individual who owns up to 10% of the 
company’s stock. 
 
Officer Title: This shows the title the Insider holds within the company. Ex..Chief 
Executive Officer 
 
Financial Product: This shows the type of financial product that was involved in the 
transaction. There are various products like Common stock, Options, Warrants. I’d 
recommend you learn more about each and what they are. Keep in mind that financial 
products can have multiple labels for the same product. For example, stocks traded on 
exchanges can be called Common stock, Ordinary shares, Class A shares or even be 
labeled as Stock Units, but they all represent the same thing. 
 
Transaction Date: This shows the date the stock trade was carried out. 
 
Num Shares Traded: This shows the number of shares traded in each transaction. 
 
Price Per Share: This shows the price at which each share was bought for in the 
transaction carried out. Note, If you look through the data you can see some 
transactions have a purchase price of $0, those are usually options or other financial 
products that  are usually incentives given to insiders. 
 
Total Transaction Value: This is the total value of each transaction carried out. 
Basically, the number of shares traded multiplied by the price of each share. 
 
Transaction Type: There are 2 transaction types, A for Acquired which can also 
represent a Buy, and D for Disposed which can also represent a Sale. 
 
Transaction Code: The transaction codes show what type of transaction was carried 
out by the insider. For most day traders and swing traders, the most important 
transaction codes when trading with insider data are,  P (Open market purchase) and S 
(Open market sale), those are trades carried out in the open market like most other 
trades. There are also codes like M (Option exercise) and A (Stocks given as an 
award/grant) which can still signal a good opportunity. Depending on the strategy you 
use, the transaction codes you look for can be different. 
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You can view all the official transaction codes and their full description here on the SEC 
website, https://www.sec.gov/edgar/searchedgar/ownershipformcodes.html. 
 
Post Transaction Value: This represents how many shares of the company the insider 
has in their possession after the transaction was carried out. 
 
Ownership Type: There are 2 ownership types D for Direct and I for Indirect. Indirect 
ownership is usually seen when the transaction is carried out by an Insider for someone 
else, like their spouse, children or through a Trust. 
 
 
Relevant Date: Same as the Transaction Date. 
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ANALYZE CLEANED DATA 
 
Using Filters 
 
Filters are a great way to narrow down and understand your data better. They help you 
cut out the noise so you can focus on the transactions you really want to see. 
 

 
 
 
 
 
With the full spreadsheet selected, select the Data tab, then select “Create a filter” from 
the dropdown menu. 
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I’d also advise that you freeze the top row containing the headers. You can do this by 
right-clicking on Row 1, hovering over the last option to “View more row actions” then 
select “Freeze up to row 1”. This makes sure the headers are always visible and makes 
it easier for you to know what column you’re looking at even when you scroll all the way 
down. 
 
Now with the filters set you are able to dive into your data a bit more by using the drop 
down menu the filters provide for each column. Ex..Under Price Per Share you can  
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deselect all Blank rows and rows with $0 transaction prices to help filter out some 
incentive transactions from your analysis. 
 
Extra Tip: Use CTRL+F, to search through your table. A search bar should come up at 
the top right of your spreadsheet and whatever you input will be highlighted on the 
spreadsheet. Use the arrows to move through all highlighted sections. 
 
 
 
Using Pivot Tables 
 
Pivot Tables are great for summarizing your data so you can get the full gist of what it's 
trying to tell you. With a Pivot table, you can find out the most bought or most sold stock 
of a particular trading day, whether based on the number of shares traded or the total 
value of the transaction. You can also find out which stock was traded by the most 
insiders or see how much money insiders put in or took out of the stock market as a 
whole on a particular trading day. This really helps you know whether there is significant 
volume coming into the market or into a stock you might be interested in, which helps 
you get on the wave and not miss the trend. 
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Under the Insert tab, select the “Pivot table” option. 
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Leave everything as is and select create. This should take you to a new sheet that looks 
like the one below. 
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The 2 columns on the right will be how you will be factoring in and factoring out parts of 
your data.  
 
Notice the 4 sections, Rows (Shows all data in this section on rows), Columns  (Shows 
all data in this section on columns), Values  (Shows all data in this section as numerical 
values. This can help with calculations like getting the sum, count or average) and 
Filters (This acts like the filters discussed earlier and allows you to include or exclude 
parts of the data). From the list of headers on the very right, you can drag and drop 
them into either of these 4 sections and see what happens. I recommend you play 
around with it to get a better feel of how it works. 
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Example: For the image below, I have dropped the Ticker Symbol header into the Rows 
section, now all ticker symbols are laid out on their individual rows. 
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I can then drag the Ticker symbol header into the Values section and now it shows how 
many transactions there are for each stock symbol. 
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Below, this pivot table shows some vital information for the average trader or investor. 
The criterias set are: 
 
Rows:  

Ticker Symbol: Order (Descending), Sort by: Sum of Total Transaction Value. 
Show totals (Unchecked). 
 

​ Transaction type: Default setting, except Show totals (Unchecked). 
 
Values:  
​ Total Transaction Value: Summarized by (SUM). Show as (Default). 
 
 
Filters: 

Transactions Date: Days selected 11th -17th of December 2025. This basically 
shows you a week of data (5 trading days). 
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From this pivot table, you can see that ROIV (Company Name: Roivant Sciences Ltd.) 
has the most money flowing in and out of it which would most likely create a lot of 
volatility, meaning a lot of opportunities for traders both on the long and short side. This 
is just one of the many criterias you can set using Pivot tables to get quality information 
out of your data and make meaningful decisions in your trading and investing.  
 
Pro Tip: I recommend you use a much longer time frame when filtering with Transaction 
dates if you are more of a long term investor. Make adjustments depending on the kind 
of trading/investing you are doing. 
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GOOD TRADE SIGNALS WHEN USING INSIDER DATA 
 
Data can tell you a story if you are ready to dig a little bit to find the answers. Below are 
a few hints and signals you can draw out of the insider data using some of the tips in the 
InsiderIQ Pro guide. 
 
Cluster Buys: The more the merrier, when you see multiple insiders buying or selling a 
stock at once, all in the same day especially? It would be in your best interest to take a 
closer look. 
 
High Insider Purchase Price: You might not know this but quite regularly you can spot 
insiders buying their company stock at a higher price than it currently is at or selling at a 
lower price. This is a really good sign as it shows more conviction on their part and even 
a sense of urgency to get in on a particular move. 
 
Large Buys (Number of Shares & Total Transaction Value): With most brokerages 
you are able to see the numbers of shares a stock trades on average during a particular 
amount of time, like its average volume for a month, 6 months and even a year. When 
you see a sale or purchase have a larger volume than the stock's usual average, that's 
a good time to pay attention. The volume average you choose for your comparison will 
depend on if you’re day-trading, swing-trading or doing long-term investing. The total transaction 
value can also show you which stock had the most money put into it or pulled out of it on any 
given day. 
 
Consecutive Buys: When you see buys or sales over multiple days, that’s a good sign. 
Especially when you see the number of shares bought or sold going up with each day. Added 
bonus if the price the stock is bought at increases with each following day or vice versa for a 
sale. 
Try and find stocks that meet some of the criterias above and let us know if you see that they 
end up being good signals for you as our research has shown them to be. 
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HELPFUL TOOLS ON GOOGLE SHEETS 

 
Google Finance Functions. 
 
Google finance functions can help you get more financial data into your hands to assist 
with your analysis. Let's look at a simple function like the one below: 
 

=index(GOOGLEFINANCE(CELL1, "PRICE", CELL2),2,2) 
 
 
CELL1: Ticker Symbol 
CELL2: Date 
 
 
 
Example:  
 
=index(GOOGLEFINANCE(GOOGL, "PRICE", 12-03-2025),2,2) = $319.630 
 
The following day: =index(GOOGLEFINANCE(GOOGL, "PRICE", 12-04-2025),2,2) = 
$317.620 
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This simple formula can save you a lot of time by giving you financial data directly in 
your spreadsheet. Now if I’m testing out a strategy and my data analysis shows a long 
opportunity in Google, I’d take some time to put my data analysis theory to the test and 
see if my theory holds up. I’ll do this by comparing price changes over time, comparing 
the price of the stock the day it has an insider transaction that stands out to its price the 
following day or a week after. You’d just need to change the date in your formula.  
 
 
Pro Tip: Investors and Traders think in percentages. Using a percentage change 
formula to see how the price of a stock changed the following day, week or month can 
help with some cues and strengthen your game plan. 
 
For more information: https://support.google.com/docs/answer/3093281?hl=en  
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Automate your Workflow with Macros. 
 
After analyzing your data, coming up  with some theories, putting them to the test and 
settling on some conclusions about certain insider transactions that give you predictable 
moves in the market, you may finally be ready to automate your workflow.  
 
Marcos is a helpful tool within Google sheets under the “Extensions” tab that can help 
you automate a lot of things from removing duplicates, creating filters, to the creation of 
your pivot tables. I don't recommend you try to automate the upload of the csv file, but 
after that you can pretty much automate most things.  
 
To do this, hover your mouse over the Macros option in the drop down menu then click 
on Record Macros. Then you now have to carry out all the steps listed in this guide, 
clean up your data, set up your filters then set up your pivot table. Once that is done 
and your Macros is named, anytime you need those steps carried out after you’ve 
imported your data, you can just go to the Macros option and select your Macro and it 
will then carry out all the steps you previously recorded. 
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Click Record macro and carry out all the steps in your data analysis process you would 
like automated. 
 
Caution: It isn't full proof, you will still need to check on its work, but it does reduce 
some work on your part over time. 
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FINAL THOUGHTS 
 
Finding a diamond in the rough can take some time, we at InsiderIQ Pro are glad to 
walk alongside you on your journey. This guide will be updated as we discover more 
ways to extract more quality information from insider transactions. We implore you to 
get as creative as possible, keep learning and growing your data analysis skills. We 
would love to hear from you about other ways you have been able to get the most out of 
the data provided, and are open to any helpful tips and tricks you’d love to share with us 
and the InsiderIQ Pro community. You can reach us via our email address, 
insideriqpro@gmail.com.  
 
Congratulations on your new journey, Analysts! Hope to hear from you soon. 🙂 
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